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Application Note

The transition to digital has enabled great strides in the
processing of video signals, allowing a variety of
techniques to be applied to the video image. Despite
these benefits, the final signal received by the customer 
is still converted to an analog signal for display on a 
picture monitor. With the proliferation of a wide variety 
of digital devices - set-top boxes, Digital Versatile Disk
(DVD) players and PC cards - comes a wide range of
video formats in addition to the standard composite 
output. It is therefore necessary to understand the 
requirements for measuring analog component High
Definition (HD) signals in order to test the performance 

of these devices. When an image is captured by a color
camera and converted from light to an electrical signal, 
the signal is comprised of three components - Red,
Green and Blue (RGB). From the combination of these
three signals, a representation of the original image can be 
conveyed to a color display. The various video processing
systems within the signal paths need to process the
three components identically, in order not to introduce 
any amplitude or channel timing errors. Each of the three 
components R’G’B’ (the ( ’ ) indicates that the signal 
has been gamma corrected) has identical bandwidth,
which increases complexity within the digital domain. 

Requirements for Measuring Analog Component HD Signals for 
Video Devices



Y’, P’b, P’r Analog Component 

Format 1125/60/2:1 1920x1080 525/59.94/1:1
1920x1035 (SMPTE 274 M) (SMPTE 273), 
(SMPTE 240 M) 1280x720 625/50/1:1

(SMPTE 296 M) (ITU-R.BT.1358)

Y’ 0.701 G+0.087 B’+0.212 R’ 0.2126 R’+ 0.7152 G’+ 0.0722 B’ 0.299 R’+0.587 G’+0.114 B’

P’ (B’-Y’)/1.826 [0.5/(1-0.0722)](B’-Y’) 0.564(B’-Y’)

P’r (R’-Y’)/1.576 [0.5/(1-0.2126)](R’-Y’) 0.713(R’-Y’)

Table 2. Conversion of Y’,B’-Y’,R’-Y’ into Y’, P’b, P’r.

To reduce the bandwidth required, we convert the R’G’B’
signals into a single luma signal Y’ made from portions of
the Red, Green and Blue as defined by the equations in
Table 1. In order to convert the signal back to its R’G’B’
components for final display, we need two other color 
difference signals - B’-Y’ and R’-Y’. These signals have a
reduced bandwidth, since the detailed picture information 
is carried by the full bandwidth luma channel. A simple
matrix circuit converts between R’G’B’ and Y’, B’-Y’, R’-Y’
allowing bandwidth reduction and easier implementation of
digital processing. Conversion of Y’, B’-Y’, R’-Y’ into
Y’P’bP’r is often done to allow similar dynamic ranges of
the luma and color difference signals. Typical amplitude
ranges for R’G’B’ signals are 0 mV to 700 -. The 
conversion to Y’ gives an amplitude range of 0 mV to 
700 mV but the color difference signals each have 
different amplitude ranges:

R’-Y’ is +/-491 mV for 525 or 625 and 
+/-551 mV for 1125 & 750

B’-Y’ is +/-620 mV for 525 or 625 and 
+/-650 mV for 1125 & 750

To simplify the process, scaling factors are added to B’-Y’
and R’-Y’ components so that the dynamic ranges of the
signals are +/- 350 mV as shown in Table 2. To indicate
this, the values are termed P’b (scaled B’-Y’ component)
and P’r (scaled R’-Y’ component). 

There are a variety of different measurement parameters
that need to be quantified in analog high definition 
component systems. Some of these will be similar to those
measurements done in the composite domain. These types
of measurements are detailed in two Tektronix publications:
Television Measurements - PAL Systems (25W-7075-01)

and Television Measurements - NTSC Systems (25W-7049-03).
Composite measurements, however, such as Differential
Gain and Differential Phase have little meaning within a
component signal. Used exclusively in the composite domain,
these tests relate to the measurement of the modulated
chrominance gain relative to luma level or the uniformity of
chrominance phase to luma level. In analog component
video, the chrominance signal is represented by the two
separate color difference components. Therefore different
measurement methods are employed. The number of 
different measurements required for quantifying component
signals are less than in the composite domain, however the
measurements have to be applied to all three components. 
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Table 1. Conversion of R’G’B’ into Y’,B’-Y’,R’-Y’.

Y’, R’-Y’, B’-Y’, Commonly Used for Analog Component Analog Video

Format 1125/60/2:1 750/60/1:1 525/59.94/1:1, 625/50/1:1

Y’ 0.2126 R’ + 0.7152 G’ + 0.0722 B’ 0.299 R’ + 0.587 G’ + 0.114 B’

R’-Y’ 0.7874 R’ - 0.7152 G’ - 0.0722 B’ 0.701 R’ - 0.587 G’ - 0.114 B’

B’-Y’ - 0.2126 R’ - 0.7152 G’ + 0.9278 B’ - 0.299 R’ - 0.587 G’ + 0.886 B’



Automated Measurements

Tektronix has developed an automated measurement 
package for analog component SD and HD video systems,
the VM6000 shown in Figure 1. Once configured, the
instrument can make a series of automated measurements
on the device under test (DUT). Connections to the
VM6000 may be configured in a variety of ways, depending
upon the type of outputs available from the DUT. Within a
component system, the synchronizing signal can be carried
on a variety of the channels. Broadcast standard Y’P’bP’r
SD format sync, for example, is carried on the Y channel
and is a bi-level sync signal). In Y’Pb’Pr’ HD formats, 
however, a tri-level sync is used and may be carried on 
all channels; in R’G’B’ HD formats the sync can be on 
one or all of the components, carried as a separate sync
(RGBS) or with separate H and V sync (RGBHV), as is 
typical in the VGA outputs of a PC. It is therefore important
to set up the VM6000 correctly for the appropriate type of
input format being used.

For configurations using either Y’P’bP’r or R’G’B’, with
composite sync on Y’ or G’, the system can be set up 
as shown in Figure 2, with the Y’ or G’ signal connected to
Channel 1 of the VM6000. This configuration provides for
accurate Frequency Response and Multiburst measurements
while providing a more accurate low-level Noise measurement.
The Sync Pickoff accessory, Tektronix part number 
012-1680-01, used in conjunction with a TPA-BNC Tekprobe™
BNC adapter, provides a low capacitance connection to 
the Channel 1 signal and avoids some of the connection
problems in other methods of connecting the device under
test to the VM6000. The trigger source is set by default
to Channel 4. 
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Figure 1. VM6000 for analog HD automated measurements. Figure 2. Preferred connection of YPbPr/GBR to VM6000 .
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Figure 3. Connection of YPbPr/GBR to VM6000. Figure 4. Component connection with separate sync. 

If the sync pickoff fixture is not available, for configurations
using either Y’P’bP’r or R’G’B’ with composite sync on Y’
or Green, the system can be set-up as shown in Figure 3
with the Y’ or G’ channel connected to Channel 1 of the
VM6000. This configuration provides for accurate Frequency
Response measurements, but limits the range of the Noise
measurement to -65 dB (30 MHz) on the Channel 1 input.
In this case, the synchronization for the VM6000 would be
set to Channel 1.

A four-wire system that provides a separate sync output
from the device under test can be configured as shown in
Figure 4. With this approach, synchronization is obtained
directly from Channel 4. 
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Figure 5. PC VGA connection to instrument. Figure 6. Termination at input to instrument (VM6000  shown).
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In the final configuration, a special cable, Tektronix part 
number 012-1664-00 VGA Sync Combiner, which provides
the three video channels and combines H and V syncs allows
direct connection to a PC and correctly interfaces to the
VM6000 as shown in Figure 5. This cable combines the 
separate horizontal and vertical syncs from the VGA output
into a composite sync so that it can be directly applied 
to the Channel 4 input of the device. This configuration is 
commonly used for testing the 5 wire R’G’B’ output from 
the set-top box.

Termination and Cable Impedance

Improper termination is a very common source of operator
error and frustration. If you put two terminators in the signal
path, or leave it unterminated, the signal amplitude will be
seriously affected. It is therefore essential that you terminate
each video signal, using a 75 Ω terminator. When the signal 
is looped through several pieces of equipment, it is generally
best to terminate at the final piece of equipment. The quality
of the terminator is also important, particularly if you are trying
to measure small distortions. Be sure to select a terminator
with the tightest practical tolerances because incorrect 
termination impedance can cause amplitude errors as well 
as frequency distortions. Signal cable impedance is also
important, to avoid mismatch especially at the higher signal
frequencies encountered in HD signals. The signals from the
device under test should be connected to the VM6000 via 
75 Ω BNC cables that are terminated correctly at the input 
to the instrument are shown in Figure 6. Note that some
input adapters, such as the Tektronix Sync Pickoff 
accessory, already provide the necessary 75 Ω termination.



Test Signal

A variety of test signals are required to measure the 
performance of an analog component system. Test signals
should be repeated for a number of lines to avoid
transitional artifacts present in some compressed format
signals. However it is not necessary to apply the test 
signal over the entire field to check conformance of the 
system. Therefore different test signals can be produced 
for a certain set of lines and a matrix pattern is formed from
the combination of these various patterns. This reduces
measurement time by allowing one pattern to be used 
for a series of measurements. The measurement instrument
then makes the appropriate measurements on specific test
lines within the matrix pattern. It was necessary to ensure
that the signal would support both R’G’B’ and Y’P’bP’r 
formats when designing the matrix pattern. This in turn 
created the need to compose both a variety of R’G’B’
measurement lines and a second set of signals suitable 
for Y’P’bP’r measurements. The matrix pattern used is
shown in Figure 7 and is part of the software package 
provided with the VM6000. The next section outlines how 
a variety of these test signals can be used within
measurement routines. 

Automated Measurement using the VM6000 

The instrument is easily configured to make a variety of 
analog high definition component measurements, simply
select, or let the VM6000 automatically select, the
standard of the video signal supported and the format
(Y’P’bP’r or R’G’B’). It is important to choose the appropriate
setup for the synchronization of the instrument to either
Channel 1 or Channel 4, depending on the type of device
under test. The instrument can be setup to configure itself
automatically to the appropriate level and type of signal
applied to the inputs. This procedure is normally done only
once and saved to speed-up the measurement process.
Therefore, if the instrument is used for other functions between
automated measurements, the saved setup should be 
re-selected before continuing. The instrument can also 
perform averaging for each measurement. This is useful if
the signal is noisy and results from the measurements are
fluctuating. By increasing the averaging factor more individual
measurement results are accumulated into the average, 
giving a more stable readout. There are twelve fully automated
measurement routines provided with the VM6000 covering
almost 200 parametric measurements.

Amplitude Measurements – Color Bars

Amplitude measurements are typically performed using 
the familiar Color Bars test signal that switches on and 
off components in the R’G’B’ format to produce eight
possible combinations. There are a variety of different forms
of the Color Bars test signal, typically either using a maximum
dynamic range of 700 mV = 100% or at 75% with an R’G’B’
amplitude of 525 mV. Using Tables 3 and 4, the amplitude
ranges for the component Y’P’bP’r are given for the various
standards of 100% and 75% Color Bars. Note that component
SD and HD formats are conventionally identified by the
number of active video lines. For example the familiar 525i
or 625i composite format would have the same number of
active video lines as a 480i or 576i component signal.
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Figure 7. Matrix test pattern.



480/576 1080/720

R’ G’ B’ Y’ P’b P’r Y’ P’b P’r

Color Bar (mV) (mV) (mV) (mV) (mV) (mV) (mV) (mV) (mV)

White 700 700 700 700.0 0.0 0.0 700.0 0.0 0.0

Yellow 700 700 0 620.2 -349.8 56.9 649.5 -350.0 32.1

Cyan 0 700 700 490.7 118.0 -349.9 551.2 80.2 -350.0

Green 0 700 0 410.9 -231.7 -293.0 500.6 -269.8 -317.9

Magenta 700 0 700 289.1 231.7 293.0 199.4 269.8 317.9

Red 700 0 0 209.3 -118.0 349.9 148.8 -80.2 350.0

Blue 0 0 700 79.8 349.8 -56.9 50.5 350.0 -32.1

Black 0 0 0 0.0 0.0 0.0 0.0 0.0 0.0

High Definition Analog Component Measurements
Application Note

7www.tektronix.com/vm6000

Table 4. Amplitude ranges for various 75% Color Bars signal formats.

Table 3. Amplitude ranges for various 100% Color Bars signal formats.

480/576 1080/720

R’ G’ B’ Y’ P’b P’r Y’ P’b P’r

Color Bar (mV) (mV) (mV) (mV) (mV) (mV) (mV) (mV) (mV)

White 700 700 700 700.0 0.0 0.0 700.0 0.0 0.0

Yellow 525 525 0 465.2 -262.3 42.7 487.1 -262.5 24.1

Cyan 0 525 525 368.0 88.5 -262.4 413.4 60.2 -262.5

Green 0 525 0 308.2 -178.8 -219.7 375.5 -202.3 -238.4

Magenta 525 0 525 216.8 173.8 219.7 149.5 202.3 238.4

Red 525 0 0 157.0 -88.5 262.4 111.6 -60.2 262.5

Blue 0 0 525 59.9 262.3 -42.7 37.9 262.5 -24.1

Black 0 0 0 0.0 0.0 0.0 0.0 0.0 0.0

Depending on the type of equipment being tested, a 
variance in the actual values is allowed within some 
percentage. For instance, the progressive outputs of DVD
players can introduce setup to their outputs that can vary
the overall measured results. Variations in the level of the
components can introduce different hue and saturation 
values in the displayed picture. 

The Color Bars test signal allows the user to check for gain
inequalities between the channels and to ensure the signal 
is not distorted, which could produce severe clipping of
the signal.



The Tektronix Matrix pattern uses a 100% Color Bars signal 
in order to test the full dynamic range of each component.
The Color Bars pattern is located at the top of the matrix 
pattern; the line numbers at which it occurs are different 
for each different standard. The line numbers specified are
the default values used to generate the test matrix but 
some systems under test may line shift the image to a 
different location.

The VM6000 performs the Color Bars measurements by
first identifying the relative amplitudes of each of the 3
channels. Eight amplitude measurements are made on
each channel, giving a total of 24 measurements made 
in less than half a second; Figure 8 shows the typical 
measurement results performed on a 1080i signal. The
amplitude level of each of the bar Levels is measured 
relative to the back porch. Amplitudes are calculated 
using waveform averaged values within each identified 
bar. It is therefore important to ensure that the full video 
line is displayed in the capture window of the instrument 
if manual setup has been performed on the unit. 
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Figure 8. Color Bars measurement display. 

Format 1080p 1080i 720p 480p 576p 480i 576i

Color Bar 42-105 21-52 26-90 43-74 45-60 21-36 24-39
Line 584-615 284-299 336-351



Within the VM6000 a vector display tool is also available.
This allows the user to check the color fidelity of the signal.
The vector display is an X-Y plot of the color difference 
signal B-Y/R-Y with graticule boxes that define the Yellow,
Cyan, Green, Magenta, Red and Blue colors as shown in
Figure 10. The VM6000 display of an actual 100% Color
Bars line is shown in Figure 10 with each color component
fitting within the graticule boxes. If the signal does not fit -
within the graticule this indicates incorrect amplitude level of
the color difference components.

Levels Measurement

This measurement is similar to the Color Bars
measurement, and the default measurement setup is 
measurement of a 100% Color Bars signal. The Levels
measurement differs from the Color Bars measurement in
that the measurement timing and Levels expected in each 
of the three video channels across the lines being
measured are completely configurable by the operator.

The Levels measurement is useful when a signal differs
from the expected colorimetry, for example when a device
under test converts a signal rate from 1080i to 480p. A
device under test may convert only the rate, but not the 
colorimetry. The green bar would not be identified as a 
green bar, and the Color Bars measurement would
display a warning. Since the Levels measurement is 
independent of a standard, the user could set up the 
measurement for a custom colorimetry.
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Figure 9. Vector display construction. Figure 10. Vector display of component Color Bars.
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In the studio, a custom camera target could be created
using color patches and a reference black patch from the
standard color test chart. In addition to the reference 
patch, up to eight color patches arranged on the same
video line could be measured using the automated 
Levels measurement. Selecting the Configure Levels 
button, the measurement timing could be set at locations
for measurements of particular colors in each color patch, 
and the level captured to file as the reference under the
Configuration>Reference and Limits menus. 

This instrument configuration could then be saved under
File>Save Setup as a file of type .vmset. Additional cameras
could then be matched to the reference camera by
observing a continuously updating display of the Relative
column Levels measurement values. A custom LIMITS file
could also be set up to provide a PASS/FAIL report. This
custom Levels setup, including the custom Reference and
Limit files may be saved as a .vmset file under the VM6000 
application Files>Save Setup menu selection and recalled 
for future use.

Figure 11. Levels display of an SD signal with HD colorimetry. Figure 12. Custom timing configuration of VM6000 Levels
measurement.
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Multiburst Measurement

This Measurement evaluates the ability of the system to 
uniformly transfer signal components of different frequencies
without affecting their amplitude. This amplitude variation is
expressed in dB or percent. The reference amplitude (0 dB,
100%) is typically the bar or flag, or some low frequency to
which the other frequency components are compared. It is
important to know the measured amplitude and frequency 
at which the measurement was made.  

There are three Multiburst test signals - one for R’G’B’ 
using a 100% amplitude and six sinusoidal packets; a 
420 mV peak-to peak amplitude (60.0%) for Y’P’bP’r 
with half bandwidth frequency packets; and a Y’P’bP’r
mixed Multiburst signal containing both full bandwidth 
packets for Y and half bandwidth packets for color
difference with 320 mV peak-to peak amplitude (45.7%). 
It is necessary to use variations of the test signal so that it 
is compatible when converted from the Y’P’bP’r domain 
to the R’G’B’ domain. Table 5 summarizes the different
Multiburst packet frequencies and bar/flag amplitudes 
used for the various standards. The following table shows
the default line locations for the various Multiburst signals.

Format 1080p 1080i 720p 480p 576p 480i 576i

RGB Line 234-297 117-148 186-217 123-138 173-188 61-68 88-103
680-771 324-331 400-415

Format 1080p 1080i 720p 480p 576p 480i 576i

YPbPr 490-553 245-276 314-377 235-266 301-332 117-132 152-167
Mixed Line 808-839 380-395 464-479

Format 1080p 1080i 720p 480p 576p 480i 576i

YPbPr Half 544-617 277-308 378-441 267-298 333-364 133-148 168-183
BW Line 840-871 396-411 480-495



Format Flag Packet 1 Packet 2 Packet 3 Packet 4 Packet 5 Packet 6

Amplitude (MHz) (MHz) (MHz) (MHz) (MHz) (MHz)

RGB 700 mV 10 20 30 40 50 60
1080p (0 mV-700 mV)

RGB 700 mV 5 10 15 20 25 30
1080i & 720p (0 mV-700 mV)

Y Mixed BW 320 mV 10 20 30 40 50 60
1080p (620 mV-300 mV)

Y Mixed BW 320 mV 5 10 15 20 25 30
1080i & 720p (620 mV-300 mV)

Pb/Pr Mixed 320 mV 5 10 15 20 25 30
1080p (+/- 160 mV)

Pb/Pr Mixed 320 mV 2.5 5 7.5 10 12.5 15
1080i & 720p (+/- 160 mV)

Y Half BW 420 mV 5 10 15 20 25 30
1080p (560 mV-140 mV)

Y Half BW 420 mV 2.5 5 7.5 10 12.5 15
1080i & 720p (560 mV-140 mV)

Pb/Pr Half BW 420 mV 5 10 15 20 25 30
1080p (+/- 210 mV)

Pb/Pr Half BW 420 mV 2.5 5 7.5 10 12.5 15
1080i & 720p (+/- 210 mV)

RGB 700 mV 2 4 6 8 10 12
576p & 480p (0 mV-700 mV)

Y Mixed BW 320 mV 2 4 6 8 10 12
576p & 480p (590 mV-270 mV)

Pb/Pr Mixed 320 mV 1 2 3 4 5 6
576p & 480p (+/- 160 mV)

Y Half BW 420 mV 1 2 3 4 5 6
576p & 480p (560 mV-140 mV)

Pb/Pr Half BW 420 mV 1 2 3 4 5 6
576p & 480p (+/- 210 mV)

RGB 700 mV 1 2 3 4 5 6
576i & 480i (0 mV-700 mV)

Y Mixed BW 320 mV 1 2 3 4 5 6
576i & 480i (590 mV-270 mV)

Pb/Pr Mixed 320 mV 0.5 1 1.5 2 2.5 3
576i & 480i (+/- 160 mV)

Y Half BW 420 mV 0.5 1 1.5 2 2.5 3
576i & 480i (560 mV-140 mV)

Pb/Pr Half BW 420 mV 0.5 1 1.5 2 2.5 3
576i & 480i (560 mV-140 mV)
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Table 5. Multiburst packet frequencies for each video format.
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The VM6000 Automated Video Measurement Set is 
based on a 1 GHz oscilloscope with full four channel DPO
functionality. It therefore has an extremely flat Frequency
Response over the narrower bandwidth of video signals,
which have a bandwidth of 60 MHz for the 1080p formats,
30 MHz for 1080i and 720p formats, 12 MHz for 576p and
480p formats and less than 6 MHz for 576i and 480i. The
instrument’s wide bandwidth improves the frequency 
performance of the application to accurately measure the
Multiburst of the video signal. The algorithm used to make
the calculations is able to perform effectively under noisy
conditions, as well as any translation of the native signal
through MPEG compression or to other video formats. The
six largest frequency isolated peaks are found within the
spectrum of the signal. The original test signal has frequency
packets that are sufficiently isolated from each other, 
however if the device under test has performed significant
processing, multiple aliased frequencies can be present
within the signal. In such a case, the algorithm chooses 
the six most isolated peaks within the spectrum display.
The frequency packets are displayed on the unit in lowest
to highest frequency order. The maximum amplitude of the
packet is obtained from a cross-correlation between the
pedestal area and a windowed complex sinusoidal. 

Figure 13. VM6000 Multiburst measurement. 

1313www.tektronix.com/vm6000

Figure 13 shows the measurement made on the mixed
bandwidth Y’P’b’P’r signal from a test signal generator 
with little degradation in signal performance. Frequency
response problems can produce softening of the picture,
with vertical edges becoming fuzzy and smeared. This 
can happen when the device under test lacks a suitable 
reconstruction filter with sin(x)/x correction for the video 
signal. This can lead to a roll-off in the fundamental 
frequency component of the packet, even though the 
envelope of the packet may be flat.

In this case, the amplitude results for the highest frequencies
may be lower by a few dB, even though the packets may
look closer in amplitude on the display. This is because 
the packet is no longer a pure windowed sinusoid, but 
has other spectral components. If the extra spectral 
components are removed by appropriate filtering, the 
signal envelope will better reflect the actual measurement
of Frequency Response for the processed signal at that 
particular frequency. 



Native 5 MHz 10 MHz 15 MHz 20 MHz 25 MHz 30 MHZ
1080i Y

Full BW 4.85 MHz 9.71 MHz Aliased Aliased Aliased Aliased
480p Output 14.6 MHz 19.4 MHz 24.3 MHz 29.1 MHz

Native 2.5 MHz 5 MHz 7.5 MHz 10 MHz 12.5 MHz 15 MHz
1080i Pb/Pr

Half BW 2.43 MHz 4.85 MHz Aliased Aliased Aliased Aliased
480p Output 7.28 MHz 9.71 MHz 12.13 MHz 14.56 MHz
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Figure 14 shows the results from a set-top box producing 
a native 1080i output. Notice the aliasing of the increasing
frequency packets. Depending on the application of the
device, these performance limits may be acceptable. 

In various set-top boxes, the native format applied to the
unit is digitally converted to another display format. When
this happens the original packet frequencies from the native
test signal will be transposed to other packet frequencies
depending on the algorithm used to perform this operation.
With reference to the chart below, consider the following
example for conversion of a native 1080i signal into a 480p

display format. The down conversion process will vary
depending on the algorithm that is used to re-sample the
1080i signal into a 480p standard and some of the original
frequency packets will be aliased into different frequency
packets. This will depend on the sampling frequency and 
filter characteristics of the output device. The measurement
results in Figure 15 show the resultant conversion of a 
set-top box from 1080i to 480p. In this example, only two
packets of the Multiburst signal were correctly processed.
The other packets were aliased into a variety of different 
frequency components.

Generally, conversion to 480p changes the frequency by a factor of 
(1920/720)x(27/74.176) = 0.9707, with frequency aliases above 
(27 MHz/2) = 13.5 MHz for Y, R, G & B and either 13.5 MHz or 
(13.5 MHz/2) = 6.75 MHz for Pb & Pr:

Figure 14. Set-top box output of a native 1080i signal. Figure 15. Set-top box conversion of native 1080i to 
480p standard. 

14 www.tektronix.com/vm6000



High Definition Analog Component Measurements
Application Note

15www.tektronix.com/vm6000

Non-Linearity Measurement

Non-linearity is present when gain of the system changes
with amplitude level. This amplitude distortion is a result of
the system’s inability to uniformly process the component
information over the entire amplitude range. Comparing the
amplitudes at various steps in increments either of a ramp 
or staircase test signal, the difference between the largest
and smallest measurement is expressed as a percentage of
the largest step amplitude. The test signal used within the
matrix test pattern is a valid ramp which can be used for
both R’G’B’ and Y’P’bP’r. The valid ramp consists of three
ramps within the line, the first of which is a luma ramp used
for Y’,R’,G’,B’. The second ramp is used to make the P’b
linearity measurement and the third ramp is used for P’r. 
This is located at the following default lines within the 
various video standards:

Format 1080p 1080i 720p 480p 576p 480i 576i

Valid Ramp Line 746-808 373-404 506-569 363-394 429-460 181-196 216-231
936-967 444-459 528-543

The measurement results show packet frequencies different
than the theoretically calculated non-aliased values because
they are frequency aliases predicted by Nyquist sampling
theory. In addition, the lack of anti-aliasing filtering and/or
the lack of reconstruction filtering may cause products to
contain multiple frequency components, which may affect
the results. Therefore, further analysis is required to
characterize the performance of the set-top box, which 
can be manually done by using the oscilloscope functions
of the VM6000 or by using the Frequency Response 
measurement. However, in such cases the results will 
show that the Frequency Response deviates substantially
from the norm. 
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The measurement is made at six equal time intervals across the
ramp and the results are given as a percentage deviation from
the ideal linear increase in the test signal. The measurement
results are displayed in Figure 16 for a typical progressive DVD
player output. Notice the overall maximum value is displayed
along with the measurement of the five locations across the
ramp. In this example the luma signal shows some slight 
deviation occurring at the middle amplitude levels, which are
probably within acceptable limits for the performance of the
unit. Most people are not particularly sensitive to luminance
Non-Linearity in black and white pictures. If large amounts of 
distortion are present however, you might notice the loss of
detail in the shadows and highlights. These effects
correspond to crushing or clipping of the black and white
image. However, color shifts due to channel mismatch can 
be apparent.

Figure 16. Non Linear measurement of a DVD player.
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Noise Measurement

Noise is present within any electrical system and comes from
a variety of natural and man-made sources that can either be
random or coherent in nature. An excessive amount of Noise
within the system tends to degrade the signal. In extreme
cases, Noise can make it difficult for equipment to synchro-
nize to the signal. Errors may become visible at approximately
40 dB signal-to-Noise and produce sparkle or snow effects in
the picture. The degree of impairment depends on a variety of
factors, including spectral distribution of the Noise. 

CCIR Recommendation 576-2 for SD formats provides 
information on weighting filters used to characterize the Noise
spectrum to better match the visibility of Noise in typical 
viewing conditions. These weighting filters have been modified
for each of the HD video formats used within the VM6000 to
match the “visibility” of Noise characteristics. In addition to
OFF, two weighting filters are provided; a Unified Weighting 
filter as described in Recommendation 576-2, and an
Unweighted Bandwidth filter adjustable by the user from 
200 kHz to 250 MHz.

To measure Noise, a pedestal signal is used at a 7.5%, 50%
or 100% level for Y’, R’, G’, B’ and 0% for P’b and P’r. These
signals are located at the following default positions in the 
various video standards:

Format 1080p 1080i 720p 480p 576p 480i 576i

7.5% 938-1000 469-500 634-659 459-474 525-556 221-236 264-279
1032-1063 484-499 576-591

50% 1002-10064 501-532 660-697 475-490 557-588 237-244 280-295
1064-1095 500-507 592-607

100% 1066-1120 533-560 698-745 491-525 589-620 245-262 296-310
1096-1123 508-525 608-622



The VM6000 Noise measurement may also be configured
using time cursors to measure a quiet segment of any line.
Select a line for measurement using the oscilloscope’s top
taskbar Trig>Video Setup, and select an appropriate format.
Trigger on Line# and select a line. Return to the VM6000
application with Analyze>VM SD and HD Video. In the
Trigger - Video and In the Results>Noise window, click Set
Time Window. Click on Custom in the Time Window
Configuration window and drag the time cursors to 
encompass a part of the line with no high frequency 
disturbances. Click Apply and run the Noise measurement.
Noise will be measured in the selected time-window of 
the selected line, as shown in Figure 18.
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Format 1080p 1080i 720p 480p 576p 480i 576i

YPbPr 410-472 405-436 570-601 395-426 461-492 197-212 232-247
Shallow Ramp 968-999 460-475 544-559

RGB 474-936 437-468 602-633 427-442 493-524 213-220 248-265
Shallow Ramp 1000-1031 476-483 560-575

Since this measurement disregards hum and tilt, shallow
ramp signals can also be used to measure the Noise
present within the signal. There is a luma shallow ramp for
R’G’B’ which is centered at the 50% point and varies from
315 mV to 385 mV (+/- 35 mV). For Y’P’bP’r component
signals the luma signal varies from 315 mV to 385 mV
(+/- 35 mV) and the color difference signals vary by 
+/-35 mV centered around 0 mV.

Figure 17. VM6000 Noise measurement. 
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Figure 18. Set time cursors can define Noise measurement
interval in a complex signal. 

Figure 19. VM6000 Noise spectrum display from a DVD player. 

A spectrum display is also available within the Noise
measurement application. This measurement shows the 
Noise power vs. frequency present within the signal. In order
for this display to be calculated the VM6000 must be set-up
in Configuration>Operation>Run Mode>Continuously. The
spectrum display can show specific Noise-frequency 
components which maybe interfering with the video output 
as shown in Figure 19, such as mains frequency hum. This
would show up as an amplitude spike around the 60 Hz or 
50 Hz region of the display. Hum can produce a light and 
dark banding moving vertically through the picture.
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Figure 20. Channel Delay measurements. 

Therefore, an algorithm was developed within the VM6000
which detects cross-correlation between the channels using
a standard sweep signal. Additionally, other types of highly
correlated signals such as Multiburst or chirps or even live
program material can also be used. If a measurement
cannot be performed on the signal selected because of 
the lack of cross-correlation between the channels, the
display will show “---” for each channel and an associated
“low correlation between channels” warning message may
be observed. The measurement finds the maximum
cross-correlation of the transitions of the signal between
each pair of channels. The delay corresponding to maximum
cross-correlation is obtained and displayed in time. A variety
of test line signals can be used for Channel Delay provided
there is good correlation between the channels. The following
test signal lines contain sweep signals for use with R’G’B’ or
Y’P’bP’r formats at the default locations. The measurement
results are shown in Figure 20; each Channel Delay is
compared against the other. The positive number for the
measurement of channel Pb & Pr indicates that there is a
delay in Pb with respect to Pr of approximately 0.33 ns. A
positive value of the measurement of Y to Pb indicates there
is a delay of Y with respect to Pb of approximately 1.45 ns.
The delay measurement result is the time shift required to
obtain maximum cross-correlation between the respective
parts of the signals. This shift or delay may, in some cases,
be frequency dependent. Group delay plots may be obtained
by measuring the delay of various narrow band signals.

Format 1080p 1080i 720p 480p 576p 480i 576i

RGB HF 138-200 69-100 122-153 91-106 125-156 45-52 56-71
Sweep Line 632-663 308-315 368-383

Channel Delay Measurement

Channel Delay measurements are used to verify the relative
timing of the three video channels. It is important when
making this measurement to ensure that the cables used 
to connect the DUT and VM6000 are of the same length 
for each signal path otherwise errors in the results can occur.
Thus it is important to either trigger on Channel 1 or use 
the special high impedance, low capacitance, high frequency
fixture to connect the sync component to Channel 4. The delay
can arise through inequality in the different paths for each
signal. In video systems, a Bowtie signal has been used to
characterize the delay between each channel. (For further
information please refer to the Tektronix application note
Solving the Component Puzzle, 25W-7009-02.) However,
this requires a special test signal, which may be degraded
by processed systems such as MPEG compression or Noise.  

Format 1080p 1080i 720p 480p 576p 480i 576i

YPbPr 362-424 181-212 250-281 171-202 237-252 85-100 102-135
HF Sweep 744-775 348-363 432-447
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Figure 23. VM6000 Horizontal Sync measurement results for 
an HD signal. 

Figure 21. HD Tri-Level Sync Timing measurements. Figure 22. SD Bi-Level Sync Timing measurements.

Horizontal Sync Measurement

This measurement checks the signal timing and amplitude
for the horizontal blanking interval of the appropriate video
standard to ensure that synchronization signals conform to
the standard. Any of the active lines within the matrix test
signal can be used to perform this measurement. If another
signal is used, the active video signal amplitude should be
greater than 7.5% in order to measure front and back porch
accurately. If the signal is not of sufficient amplitude, the
VM6000 may not be able to make front and back porch
width measurements. All amplitudes are measured relative
to back porch.  

Timing intervals are measured at the 50% point of the rising
or falling edges of the signal. Rise and fall time measurements
are made between the 10% and 90% points. Start of Active
Video (AV) and End of AV are measured from the reference
point defined in the signal standard; the positive-going zero
crossing of the tri-level HD sync, or the 50% leading edge
of the SD bi-level sync. Figure 21 shows the relative positions
of the measurements made by the VM6000 for HD signals
and Figure 22 the relative positions for SD measurements.
The results are displayed as shown in Figure 23.
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Frequency Response Measurement

Various devices such as set-top boxes can reformat the
video signal such that frequencies maybe shifted from 
their original values in their native video format. Aliasing 
components may occur within the signal for instance when
a native 1080i signal is converted to 480p by the device. 
It is useful to quantify the Frequency Response of the system
and ensure the system uniformly transfers the different 
frequency components without affecting their amplitudes.

The Frequency response measurement allows the user to
define either a point in time (measured from the Sync Timing
Reference) or to find a specific frequency within the active
line. A sweep signal is typically used to make this measurement
but a Multiburst signal can also be used. The signal must
start with a flag (low frequency amplitude bar) at the front 
of the signal. Both sweeps signals and Multiburst signal
within the Tektronix matrix signal can be used. 

These signals are available in the Tektronix matrix signal 
on lines indicated in the table to the right. The more cycles
present in the burst, the more robust and accurate the
measurement will be. However a burst with less than two
cycles present within the signal is not recommended to be
used within the measurement algorithm.
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Vertical Sync Measurement

The Vertical Sync measurement, as shown in Figure 24,
checks the signal timing for the vertical blanking interval of
the appropriate video standard to ensure that synchronization
signals conform to the standard. Measurements will be
reported using any video signal, but it is important that start
and end of active video be clearly defined. If the video signal
is not of sufficient amplitude above the black level, the
VM6000 may not be able to make front and back porch
width measurements. 

The Vertical Sync measurement reports the field period, 
or periods for an interlaced signal, along with the number 
of broad pulses which occur with a negative average 
picture level (APL) to easily identify the Vertical Sync to 
low frequency analog detectors. The appropriate signal 
standard identifies these values along with the correct 
broad pulse start and end time relative to the horizontal
sync timing reference.

Figure 24. VM6000 Vertical Sync measurement results for 
an HD signal. 
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Format 1080p 1080i 720p 480p 576p 480i 576i

RGB HF 138-200 69-100 122-153 91-106 125-156 45-52 56-71
Sweep Line 632-663 308-315 368-383

Format 1080p 1080i 720p 480p 576p 480i 576i

RGB LF 202-432 101-116 154-185 107-122 157-172 53-68 72-87
Sweep Line 664-679 316-323 384-399

Format 1080p 1080i 720p 480p 576p 480i 576i

YPbPr 362-424 181-212 250-281 171-202 237-252 85-100 102-135
Half BW Line 744-775 348-363 432-447

Format 1080p 1080i 720p 480p 576p 480i 576i

YPbPr 226-488 213-244 282-313 202-234 253-268 101-116 136-151
Full BW Line 776-807 364-379 448-463

If the user selects a specific frequency for the measurement
to be made on there are two choices for the way in which
the frequency is found across the channels. In Freq4:4:4
mode the measurement routines find the same frequency in
each of the channels this would typically be used for RGB
full bandwidth channels. The other choice of Freq4:2:2

would typically be used for YPbPr formats where the 
specified frequency value would be found on Channel 1 
(Y) and the frequency value would be divided by two for 
the channels two and three (Pb/Pr). In this way the same
point in time would be found across the Y and Pb/Pr 
channels for that specific frequency.
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Figure 25. VM6000 Frequency Response measurements. 

The measurement algorithm first finds the portion of the 
signal at the time or frequency specified by the user on each
channel. The measurement routine then displays the time
and frequency of the specified location. A measurement 
of the amplitude signal is then made relative to the flag
amplitude and the resultant is displayed in dB. The flag
amplitude is also displayed. A 3µs raised cosine window 
is centered on the measurement location. The spectrum
calculation yields the threshold spectral components 
and shows signal dependent distortion components 
such as aliases and other nonlinear distortions present. 
The percentage of the distortion is calculated from the
square root of the sum of the squares of the distortions
components divided by the fundamental magnitude. 
The results are then tabulated as shown in Figure 25.
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Short Time Distortion Measurement

This measurement shows the effect of linear distortion on 
the picture quality of the signal. These distortions affect 
amplitude and delay versus frequency. This can be seen 
in the picture as fuzzy edges between transitions or ringing
before or after the transition. To measure the impact of these
types of distortions a pulse and bar signal is typically used.
The pulse is used for the K2T measurement and the bar is
used for the rest of the measurements. The rise and fall time
of these pulses are typically characterized by a T or 2T
response, where T is defined:

Fmax = Maximum frequency bandwidth of video format

The K factor rating systems maps linear distortions of 2T
pulses and line bars onto subjectively determined scales of
picture quality. The various distortions are weighted in terms
of impairments to the picture. The K2T is a weighted function
of the amplitude and time distortions occurring before and
after the 2T pulse. The characterization of these types 
of distortion has been well defined in standard definition 
formats but it was necessary to transpose these types of
measurements into other HD and computer formats. The
Short Time Distortion measurement measures the rise and 
fall time, overshoot and undershoot, settling time of the 
rising/falling edges and the K2T response.

The rise and fall time are calculated on the bar using the
10% and 90% points. The result is displayed in ns. The 
overshoot is calculated as the highest excursion of the 
signal on the positive edge relative to the Vmax steady 
state. Undershoot is calculated as the lowest excursion of
the signal on the negative edge relative to Vmin steady state.
These two results are displayed in % using the steady state
value as a reference. The settling time on the rising edge is
measured from the end of the overshoot to the point where
the amplitude of the video is ringing down to +/-5% of the
final steady state value. 

1
2Fmax

T=

Format 1080i 720p 480p 576p 480i 576i

RGB Line 53-68 90-121 75-90 77-108 37-44 40-55
616-631 300-307 352-367

Format 1080i 720p 480p 576p 480i 576i

YPbPr Line 149-180 218-249 139-170 205-236 69-84 104-119
712-743 332-347 416-431

Figure 26. VM6000 Short Time Distortion measurements



As with other automatic VM6000 measurements, the
Spatial Distortion Relative tab provides a quick reference 
for measurement against ideal values. This report, Figure 27,
indicates the picture is moved down one line (Top Crop 
and Vertical Offset), and 1/3 of the bottom line is not 
visible. The left of the picture is not cropped, but the active
video starts to the right about 10 pixels after the expected
position. Vertical and Horizontal scaling are well within 1%.
The Limit file values have been exceeded for Vertical and
Horizontal position, reporting Fail. These deviations could
be acceptable for many applications and the Reference and
Limits files could be adjusted for an appropriate match to
expected performance. Consumer equipment, for example
often offers a selection of format conversions for display of
one signal aspect ratio, perhaps 16x9 on a legacy 4x3
aspect ratio display.

High Definition Analog Component Measurements
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Figure 27. Spatial Distortion relative to a reference bitmap. 

Spatial Distortion Measurement

The Spatial Distortion measurement provides a point-by-
point positional comparison of the incoming signal vs. a
stored reference bitmap version of the same signal. From
this comparison, the VM6000 determines the horizontal
start and end, vertical start and end, horizontal and vertical
size and offset, and any spatial offsets within the field or
frame. This provides a measurement of any undesirable 
distortions created by a device under test when an original
test signal in one format, for example, is converted to
another format. The Reference and Limits files may be 
custom configured for this measurement to match the
expected output of a device under test. The measurement
also provides an indication as to whether measurement line
numbers might have to be adjusted to successfully make
other automatic measurements. Any changes to default 
values may then be stored for later recall in a .vmset file
under the File>Save (or Recall) Setup menu.
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The Horizontal Sync Jitter measurement displays rapid
(Jitter) and longer term (Wander) timing instabilities in the
horizontal synchronizing signal. The operator may select 
to display a peak jitter in terms of probability, or specify a
probability a specified jitter magnitude is likely to occur. 
The user may also specify demarcation frequencies to 
isolate instabilities. For example a low pass filter cutoff 
frequency to pass long term wander, ignoring short term 
jitter variations, and a high pass cutoff filter to favor the
measurement of higher speed jitter. 

Jitter is measured in terms of ns from ideal coincidence with
the horizontal sync reference edge, and Wander in terms of
drift rate.
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Figure 28. VM6000 Horizontal Sync Jitter measurements. 

Horizontal Sync Jitter Measurement

Jitter is the rapid instability of a signal compared to some
stable reference. When the self-clocked video tries to lock
to a stable reference, for example, and succeeds in hanging
on, jitter is the measurement of how well. The reference and
video signals are locked in step, but there is some wiggle
between the two. This is jitter, usually measured in
nanoseconds, (ns), in a broadcast video signal. 

Wander is the drift a signal experiences over time, 
typically defined by a slow rate up to 10 or 20 Hz. This 
low frequency is often easier to separate from the video 
synchronizing information which occurs at a higher rate.
Video signals broadcast to the public or intended for
replay by consumer devices are generally clocked at 
frequencies well within the limits of display devices. 



Table 6. Part of Reference Limits File.
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Measurement Reporting and Limit Testing

When making a number of measurements on your device
under test or testing the quality of the device on a production
line it is essential to set some limits above or below which
the unit will fail to meet your standard specifications. Within
the VM6000 the user can select default reference and limits
files from which the measurement range can be defined or
create their own specific *.CSV files. When the measure-
ments falls outside this range the user can be warned that
the device failed a specific test or the test routine can be
halted so that corrections can be made to the device.
If you wish to create a specific set of reference and limits
files for a certain format import the default reference/limits
file into a spreadsheet program that allows importation 
of *.CSV files. Modify the files to meet your specific 
requirements and then save the file within the VM6000 
folder system. In the VM6000 configuration menu select
your new reference/limits as shown in Figure 29. Tables 6
and 7 show partial examples of the default limits and
default reference spreadsheets which can be edited for 
the users specific requirements.
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Default Reference File

This Default Reference File is provided AS IS without 
warranty of any kind and is intended to be used as a 
template only. WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE
EXPLICITLY DISCLAIMED. Copyright 2006 Tektronix.
Permission to use and create derivatives in conjunction
with VM6000 family products hereby granted. All other
rights reserved.Figure 29. Reference & Limits configuration.

Pb Level (mV)

White 0

Yellow -350

Cyan 80.2

Green -269.8

Magenta 269.8

Red -80.2

Blue 350

Black 0

Pr Level (mV)

White 0

Yellow 32.1

Cyan -350

Green -317.9

Magenta 317.9

Red 350

Blue -32.1

Black 0

Format: 1080i/60

Color Space: YPbPr

Ref

Channel Delay

YtoPb (ns) 0

YtoPr  (ns) 0

PbtoPr (ns) 0

ColorBars 

Y Level (mV)

White 700

Yellow 649.5

Cyan 551.2

Green 500.6

Magenta 199.4

Red 148.8

Blue 50.5

Black 0
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Table 7. Part of Default Limits File.

Default Limit File

This Default Limits File is provided AS IS without warranty of any kind and is intended to be used as a template 
only. WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE EXPLICITLY 
DISCLAIMED. Copyright 2006 Tektronix. Permission to use and create derivatives in conjunction with VM6000 family 
products hereby granted. All other rights reserved.

Format: 1080i/60

Color Space: YPbPr

Low High

Channel Delay

YtoPb (ns) -10 10

YtoPr (ns) -10 10

PbtoPr (ns) -10 10

Color Bars

Y Level (mV)

White 665 735

Yellow 617 681.98

Cyan 523.64 578.76

Green 475.57 525.63

Magenta 189.43 209.37

Red 141.36 155.4

Blue 47.5 53.5

Black -5 5

Pb Level (mV)

White -5 5

Yellow -367.5 -332.5

Cyan 76.19 84.21

Green -283.29 -256.31

Magenta 256.31 283.29

Red -84.21 -76.19

Blue 332.5 367.5

Black -5 5

Pr Level (mV)

White -5 5

Yellow -29.1 -35.1

Cyan -367.5 -332.5

Green -333.8 -302

Magenta 302 333.8

Red 332.5 367.5

Blue -35.1 -29.1

Black -5 5

High Definition Analog Component Measurements
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When the reference limits and limit testing are enabled, 
three additional measurement tabs are available. If the 
reference is enabled then the relative to reference and 
reference values are shown. The relative to reference
shows the deviation from the original reference values. 
It is possible while making measurement to capture the
results from your device as a reference. Figure 30 
shows a relative to reference measurement made on 
a Color Bars signal either in mV or as a percentage.

When limits testing is enabled the measured values
change from white measurement values to either green 
or red depending on whether the measurement passes 
or fails the limits testing. As shown in Figure 30 and 31 
this measurement of Color Bars fails to pass the required
limits testing for one of the Color Bars amplitudes in the
Pb/B channel. The values in red indicate that these specific 
values did not pass the limits testing and a red X symbol 
and Fail indicator is showed on the right hand side of
the measurement. The user can select the reference tab 
to show the current reference values being used and select
the limits tab to show either the maximum or minimum 
Limits being used for this measurement.

Figure 30. Relative to reference results for a Color Bars signal. Figure 31. Pass (green) or fail (red) limits testing of a Color 
Bars signal. 
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Picture display

While making measurements on your device under test it 
can be useful to investigate that your measurement are
made using the correct video line in the test matrix and that
your device under test is not overlaying a on-screen menu
which would interfere with measurements results. A Display
Picture mode, Figure 32, is available to provide a representative
image of the current signals connected to the input of 
the VM6000. 

Conclusion

Measurement of High and Standard Definition analog 
component video signals is carried out efficiently and
competently using the Tektronix VM6000 Automated Video
Measurement Set. Operating over a wide range of component
video standards, the VM6000 performs quickly and accurately
measurements that, even if possible manually, would be too
time-consuming to consider. 

The VM6000 provides a development and design 
validation tool for the Engineer; a production quality tool 
for manufacturing; and ultimately, a tool assuring a product
providing a potential for customer satisfaction. 

Figure 32. Picture display.
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